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1. Abstract 
 
Huntington’s disease (HD) is an inheritable degenerative disease of the brain characterized 
by progressive neural dysfunction and degeneration in the striatum and cerebral cortex, 
resulting in abnormal motor- and cognitive function, emotional disturbances and premature 
death. While considerable knowledge has been gained about the pathophysiological 
mechanisms of HD, curative treatment is still not available. For further elucidation of the 
pathological processes and identification of potential targets for therapeutic interventions, 
experimental investigations in animal models are necessary. Transgenic rats in which a 
truncated HD gene has been inserted, develop progressive HD-like behavioural changes, and 
thus represent a promising model for experimental investigations of HD. It remains 
uncertain to what extent striatal neurodegeneration is present in these rats, and it is therefore 
important to evaluate this quantitatively. Quantitative assessment of cellular populations is 
typically obtained using a stereological method. In order to select an appropriate 
stereological study designs for such investigations, the objective of the present study has 
been to establish a procedure for quantifying striatal cell numbers in thionin stained sections 
in the rat brain. A non-systematic literature review, combined with snowball sampling, was 
conducted to retrieve original articles and review of interest and to delineate a suitable 
design and protocol. This protocol was tested on a limited material of thionin stained 
sections from a transgenic HD-rat and wildtype littermate control. The optical fractionator 
protocol was found to be the most suitable in the objective of population estimation, and a 
set of recommended sampling parameters were identified. We conclude that the proposed 
Optical Fractionator protocol is suitable to quantitatively test the hypothesis that striatal 
neurons degenerate in transgenic HD rats.  
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2. Introduction:  
 
Huntington’s disease (HD) is an inheritable degenerative disease of the brain characterized 
by progressive neural dysfunction and degeneration in the striatum (Vonsattel et al., 1985; 
Harper, 1996; Harper et al., 1997; Heinsen et al., 1994). HD patients have an unstable, 
polymorphic CAG-trinucleotide repeat (polyglutamin) expansion within the HD gene 
(Huntington’s Disease Collaborative Research Group, 1993), leading to accumulation of 
mutant huntingtin protein in the brain. This eventually leads to regional degeneration of 
medium spiny projection neurons (MSP-neurons) in the striatum, as well as the cerebral 
cortex and other basal ganglia regions (Huntington’s Disease Collaborative Research Group, 
1993; Vonsattel et al., 1998; Heinsen et al., 1994; Hedreen et al., 1991; Sapp et al., 1999).  
Loss of basal ganglia function in turn causes symptoms of abnormal movement, emotional 
changes, motor deficits and premature death (Vonsattel et al., 1998; Folstein, 1989; Harper, 
1996).   

While considerable knowledge has been gained about the pathophysiological 
mechanisms of HD, curative treatment is still not available (Zuccato et al., 2010). For 
further elucidation of the pathological processes and identification of potential targets for 
therapeutic interventions, experimental investigations in animal models are important. 
Several different animal models have been generated in different rodent and primate species. 
This includes inducible (excitotoxin-induced, etc.) and genetically manipulated models 
(knock-in, knock-out, transgenic) (Mitchell et al., 1999).  

The first rat model of Huntington’s disease was introduced in 2003 (von Hörsten et 
al., 2003), with an insertion of truncated Huntingtin cDNA-fragment of 51 glutamine-
repeats within the original rat Huntingtin promoter. The model exhibits the adult onset of 
HD phenotype, with emotional disturbances, cognitive decline and motor deficits (von 
Hörsten et al., 2003; Nguyen et al., 2006). This is combined with neuropathological 
hallmarks of nuclear inclusions, enlarged lateral ventricles, neuropil aggregation and loss of 
projection neurons in the striatum (von Hörsten et al., 2003; Nguyen et al., 2006; Kántor et 
al., 2006; Petrasch-Parwez et al., 2007)  

While a qualitative comparisons between transgenic HD rats and wildtype control 
animals are sufficient to detect gross differences (presence or absence of protein markers, 
distinct abnormalities, etc.) (e.g. Reiner et al., 1988), are quantitative measurements 
necessary to detect more subtle differences by the use of statistical methods. Furthermore, 
since potential therapeutic interventions have a better likelihood of being effective at early 
stages of disease, is it also important to establish sensitive, quantitative measures of 
pathology.  

Stereology applies the grounding principle of statistics, topology and geometry, 
(Miyamoto, 1994) in order to retrieve unbiased quantitative information from three-
dimensional tissue based on measurements from two-dimensional histological sections 
(Lucocq, 2007; Schmitz et al., 2005). Cells loss can therefore be quantified in histological 
tissues by the use of stereological methods (Miyamoto, 1994; Lucocq, 2007; Schmitz et al., 
2005). A range of study designs have been developed for the purpose of quantifying 
different cellular parameters in histological material. 

Reduced striatal volumes have been described in transgenic HD rats (Nguyen et al., 
2006), but so far no quantitative assessment of striatal cell loss has been made. Having 
access to a collection of histological sections from transgenic HD rats and wildtype controls, 
we have the ambition to test the hypothesis that cell numbers are reduced in old HD rats. 
However, to quantify cell loss in a rodent model of a neurodegenerative disease we first 
need to select an appropriate study design and to establish a workflow for conducting such 
measurements in the available histological material.  
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The aim of the present study is thus to review stereological approaches to quantify 
cellular elements in histological tissues, and to select and apply such a method in a pilot 
investigation of HD rats. Following a literature review of stereological methods, a cellular 
quantification procedure is presented, and tested in a limited pilot study.  
 
 

3. Method: 
 
1. Literature review: 
A literature study was performed to review key articles on morphology, stereological 
methods and region of interest, with the intention of identifying approaches suitable for 
quantifying cellular elements in the available histological material. An initial non-systematic 
approach was performed using PubMed (http://www.ncbi.nlm.nih.gov/pubmed), followed 
by a so-called snowball sampling method1, to identify review articles and original papers. 
The accumulated information was used to delineate a procedure for quantifying cell 
numbers in the rat basal ganglia, using thionin stained histological material. Specifically, the 
results of the literature queries were used to 1) select an appropriate stereological design and 
counting parameters, 2) delineate the anatomical boundaries of the dorsal and ventral 
striatum, and 3) define morphological criteria for differentiating striatal cell types.  
 
2. Pilot study: 
To test the stereology procedure and validate the chosen parameters, a pilot study was 
conducted in histological material derived from two 16.5-month-old male rats, kindly 
provided by Professor Olaf Riess and Dr. Hoa Phuc Nguyen (Department of Medical 
Genetics, University of Tübingen, Germany). One rat (H29.04, +/+) was transgenic for 
Huntington’s disease (carrying a truncated HD gene with 51 CAG-repeats under control by 
the native rat HD promoter), and the other rat (H29.04, -/-), was a wildtype littermate 
control. The rats were deeply anaesthetized by sodium pentobarbital (50 mg / kg) and 
perfused with 50 ml PBS followed by 200 ml 4 % paraformaldehyde. The brains were 
extracted and postfixed overnight in 4 % paraformaldehyde, and then transferred to 
phosphate-buffered saline (PBS). Prior to sectioning, the brains were cryoprotected by 
immersion overnight in 30 % phosphate buffered sucrose. Coronal sections were cut at 50 
micrometer using a freezing microtome, mounted and stained using a standard thionin 
protocol (see box 1). Sections were dried and coverslipped using Eukitt (Kindler, Freiburg, 
Germany).  
 From each rat, four sections were chosen for this analysis in a systematic and 
random manner, spaced at an interval of 200 µm from each other within the striatum. 
Anatomically corresponding levels were identified by estimating the distance from the genu 
of the corpus collosum by section serial number and section thickness. Due to the possibility 
of bias in the process of recognition, a blinding of the investigator was proposed by an 
anonymization of the slides, after generation of a “random number” identification for each 
one of the sections, using the stereological software. Analyses were only conducted in the 
left side of the brain. Live images of the specimen were acquired through a Zeiss Axioskop 
II, EC-Plan Neofluar 63x/09 dry objective, captured with a MicroFire-digital camera 
mounted on the microscope. As detailed below, a fractionator procedure was performed 

                                                 
1 A snowball sampling method, also referred as chain-referral sampling, is a sampling method, utilized to track down 
subgroups within a vast population (Goodman, 1961). Several new objects are retrieved from the referral from a primary 
object of interest (Goodman, 1961). Applied in the interest of literature review, it would mean to search for new articles 
referred by a primary article/review. 
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Box: 1 Standard Thionin Staining Protocol  
Dry sections were defatted with alcohol of different concentration, in 
the order and time given below. 
      
 Order:     
 Substance:  Minutes:  Substance:  Minutes: 

1 Water 2 11 Water x 4 0,5 
2 70% ETOH 2 12 70% ETOH x 3 3 
3 96% ETOH 2 13 100% ETOH x 2 1 
4 100% ETOH 2 14 Xylene 1 
5 Xylene 10 15 Xylene** 1-1,5 
6 100% ETOH 2 16 Eukitt***  
7 96% ETOH 2    
8 70% ETOH 2    
9 Water x 2 1    

10 Thionin* 2    
      
* 0.05% thionin in 0.1 M acetate buffer (3 week old), pH 4 
** Stored while cover slipping    
*** Coverslipping done manually   

using the software StereoInvestigator 8.0 (MicroBrightField Bioscience Inc, Williston, VT, 
USA), with a counting frame size set to 65x65 µm², and 27-35 counting frames per sections. 
The frames were automatically positioned in a systematic random fashion by the software. 
For further details, see the procedure given in the Results section below.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. Results: 
 
The purpose of the present study was to review stereological methods in order to select an 
appropriate design to count cellular elements in histological material from a transgenic rat 
model of HD. The literature review was conducted to elucidate the following questions:  

1) Which stereology designs are suitable for measurement of altered cell numbers in 
thionin stained histological material from the rat striatum? 

2) Which cell types is the rat striatum composed of, and how can these cells be 
morphologically differentiated? 

Based on the retrieved review and articles, a practical procedure is suggested, and then 
tested in a limited pilot study. 
 
4.1. Review of stereology:  Which design is appropriate? 
 
4.1.1 Principles of stereology 
Stereology is based on the concepts of; “unbiased” and “efficiency”, defined as “...without 
the systematic deviation from the true value” and “with a low variability after spending a 
moderate amount of time”, in that order (Gundersen et al, 1988). “Unbiased” is crucial in 
obtaining information free of systematic errors, which often depends upon random sample 
site, and sometimes, specific orientations (Lucocq, 2007). Efficiency, is associated to 
reproducibility, cost etc., and has improved drastically, with the advancement of computer-
based stereology (Glaser et al., 2000). To perform measurements, a geometrical entity, 
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combined with a set of counting rules is applied, named a stereological probe (Glaser et al., 
2000; Howard et al., 1998). Various kinds of geometrical entities and counting rules exist 
(Glaser et al., 2000; Gundersen et al., 1988), and different combinations of these two, yields 
different stereological probes (will be elaborated under Choice of design, below). Since 
stereology is superimposed upon statistical probabilities, the result based on the sampling 
will only be estimates, thus furthering the need to evaluate the variability of these (Schmitz 
et al., 2005). This evaluation is defined as “coefficient of error” (CE) (Schmitz et al., 2000; 
Schmitz et al., 2005). Because of this, there is a clear realization between sample size and 
accuracy of the estimate. A higher number of sample size, number of counting frames per 
sections and number of sections, results, as follows, in a more precise estimation, and 
thereby a lower CE (Schmitz et al., 2005). 
 The fundamental question in the objective of population estimation-study is to define 
the minimum number of cellular elements to sample, to yield a valid estimate. The rule of 
thumb seems to be to count about 100-200 cellular elements/animal, as long as the CE is 
<0.1 (Gundersen et al., 1987; Gundersen et al., 1988; West et al., 1991; West et al., 1993; 
Keuker et al., 2001; etc,), even though there is no official consensus on this. Schmitz et al. 
(2000), on the other hand, recommends counting of about 700-1000 cellular 
elements/animal. With a defined cellular element count per counting frame (will be 
elaborated below), the variation lies primarily in the number of sections, both in itself and 
by affecting counting frame per section. To systemize this, a single formula is given below 
(West et al., 1991):  

 
∑Q- x 1/ssf x 1/asf x 1/tsf= N of cells 

 

N=number, SSF=section sampling fraction, ASF=area sampling fraction, TSF=thickness sampling fraction 
 

Gundersen et al., (1987) shows the sampling of 100-200 cellular elements/animal, 
distributed over 10-20 sections and 100-200 counting frames (also called disectors) to be 
adequate in most studies (Keuker et al., 2001).. This results into a counting frame enclosing 
1-2 cellular elements per frame (Gundersen et al., 1987; Keuker et al., 2001). It is proposed 
by the literature that the counting frame should not be too big, resulting in a declining 
efficiency, nor too small, leading to empty counting frames (Keuker et al., 2001). Similar to 
other parameters, is there no standardization, thus, yielding an appropriate cellular 
elements/counting frame ranging between 1-6 (StereoInvestigator Users Guide, 2008). With 
the other parameters determined, can the counting frame size and the grid size (distance 
between the different counting frames within a section) be defined. 
 Consequently, the weakness of the protocol lies in the selection of parameters, thus, a 
faulty selection results in a low precision, etc. To prevent this, a basic understanding of CE 
(coefficient of error) is capital (Schmitz et al., 2005; Keuker et al., 2001). The CE is in 
general comprised by total variance, which duty to sum up the 1) variance due to noise 
(intrasectional variance) and 2) variance of systematic random sampling (intersectional 
variance) (or any other variant of these, depending on the type of CE used) 
(StereoInvestigator Users Guide, 2008; Keuker et al., 2001). An abnormal high number of 
any of these should result in either increased sampling within a section or sampling of more 
sections, respectively (StereoInvestigator Users Guide, 2008). In an optimal situation are the 
inter- and intrasectional variance of the same magnitude (StereoInvestigator Users Guide, 
2008). An optimal CE is set to about 0.05, but most studies try to retrieve a CE of at least 0.1 
(StereoInvestigator Users Guide, 2008; Keuker et al., 2001; Gundersen et al., 1987). A part 
from this, the biological variability also has to be taken into account (Keuker et al., 2001). If 
this happens to be unknown, the recommendation seems be to conduct a study with between 
3-5 animals in both groups (Keuker et al., 2001; Cruz-Orive et al., 1990; West, 1994; 
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Figure 2: Counting frame, with in-and exclusion lines. The red lines are exclusion 
lines; the green lines are inclusion lines. All cellular elements in focus and 1) falling 
within the square, without touching the exclusion lines, or 2) touching the inclusion 
line, without being in touch with the exclusion lines, are marked with a star, and 
thereby counted. The counting square is marked by a square. 

Lucocq, 2007). Since the aim of this study is to produce a viable protocol, and not conduct a 
precise sampling, has this not been implemented in this production. 

The tissue is exposed to a heterogeneous shrinkage, combined with surface 
aberrations (lost caps etc.) from the production, both of them affecting the top and bottom of 
the sections more, because of the larger surface area (Andersen et al., 1999; Schmitz et al., 
2005). Consequently, the need for a guard zone is due, since the optical fractionator relies on 
a representable fraction of the section. The function of this zone lies in the name; it guards 
the counting frame from the corrupted part of the section along the z-axis, positioned at the 
top and bottom of the section (Andersen et al., 1999; Schmitz et al., 2005). Similar to other 
parameters, there is no unity on the size of the guard zone, but seems to range between 2-5 
µm (StereoInvestigator Users Guide, 2008; Keuker et al., 2001; Schumann et al., 2006).  

The sampling follows a set of rules (Gundersen et al., 1977; Keuker et al., 2001), 
with the aim to serve objectivity to the counting process. Apart from the criteria set to 
recognize cellular elements of interest, are the counting criteria given as follow: 1) All 
cellular elements falling within the counting square are counted, when they are in focus. 2) 
All elements touching the inclusion (green) line are counted when they are in focus. 3) All 
elements outside the square or touching the exclusion line (red), are not counted. 
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4.1.2 Choice of design 
There are different stereological approaches to estimate population density/population 
number, all with different strengths and weaknesses, (Lucocq, 2007; Schmitz et al., 2005, 
Gundersen, 1986; Mayhew et al., 1996.). So-called method-based probes are restricted to 
sampling from uniform tissues, while design-based probes also can cope with 
inhomogeneous tissue (West, 2001; StereoInvestigator Users Guide, 2008). A minimum of 
four varieties of design-based probes exist, including the Optical Fractionator, Physical 
Disector, Optical Disector, and Fractionator probes. The main difference between optical 
and physical probes relates to different preferences for sections thickness; while the 
physical-based probes are suitable for thin, parallel sections, are the optical-based probes 
more suitable for thick sections (Andersen et al., 1999; Schmitz et al., 2005). Disector 
(Sterio, 1984; Gundersen, 1986) is a probe with several variations (physical-, double- and 
optical version), and common for them all is the application of the counting frame (also 
called a disector) mentioned above (Lucocq, 2007). Fractionator (Gundersen, 1986; West et 
al., 1991), on the other hand, is a probe that measure the population within a fraction of the 
thickness, in a fraction of the areal of the whole section, and in a fraction of all the sections 
(see the formula given above) (West et al., 1991). The Optical fractionator is a combination 
of optical disector and fractionator (West et al., 1991), yielding the strength of both probes, 
thus a natural selection in this production, providing a powerful tool for population size- and 
density estimation, and used applied in many studies (Keuker et al., 2001; Schumann et al., 
2006; etc,)  
 The strength of optical fractionator relates to its independency from size, orientation 
and spatial shape of the cells/tissue, as well as changes in reference volume (Schmitz et al., 
2005; Lucocq, 2007; West et al., 1991). This provides a probe that is independent change in 
the volume (shrinkage/compression) of the region of interest (in contrast to the 
Physical/Optical Disector) (Lucocq, 2007). Since this is an optical probe, it is recommended 
that the tissue sections have a minimum thickness of 15 µm (after shrinkage due to 
preparation), and optimal over 20 µm (StereoInvestigator Users Guide, 2008). The weakness 
of the probes lies in the dependency on fixed height of the counting frame (along the z-axis) 
(West et al., 1991, Andersen et al., 1999). The insensitive nature of design-based probes, and 
optical fractionator in particular, towards the uniformity of the tissue, resides on the 
principle of systematic, random sampling (Andersen et al., 1999; West et al., 1991; Lucocq, 
2007; Schmitz et al., 2005; StereoInvestigator Users Guide, 2008). A systematic, random 
sampling of the whole region of interest, grants every cellular element within this reference 
volume the chance of beings sampled (Lucocq, 2007; StereoInvestigator Users Guide, 2008) 
(will be elaborated under Sampling parameters). Optical fractionator has also been found to 
be more efficient than many of the other methods (Lucocq, 2007). 
 Thus, to quantify cell populations in 50 mm thick thionin stained sections from the rat 
striatum, we conclude that an optical fractionator approach is most suitable.  
 
4.2 Review of cellular morphology in the striatum 
 
The striatum contains different types of projections neurons, interneurons and glial cells. 
About 95 percent of all neurons are medium spiny projection neurons (MSP-neuron) (Kemp 
et al., 1971; Mitchell et al., 1999; Dray, 1979).  

The neuron population can be categorized in three different groups based on size: 
neurons with a soma diameter smaller than 9 µm, a medium group with soma diameters 
between 10-20 µm (consisting of four different types of neurons), and a group neurons with 
soma diameters between 22 – 30 µm (consisting of one type of neuron) (Mensah et al., 
1974). There seems to be some minor variability in the population estimation and limitation 
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of the different groups of neurons between studies (Kemp et al., 1971; Dimova et al., 1980; 
Dray, 1979)., and it is unknown whether this is due to variation between different animals 
models applied or because of other variances. Regardless, Mensah et al., (1974) and Dimova 
et al., (1980), both based on rat-models, confirm high concordance with the result of Kemp 
et al., (1971), which is based on a cat-model. The variation between different species, could 
therefore be of minor importance, based on the similarities of several studies, from a vide 
range of animals (Kemp et al., 1971; Mensah et al., 1974; Dimova et al., 1980; Cajal, 1911; 
Leontovich, 1954). Thus, it seems to be possible to extrapolate the morphology described in 
cat by Kemp et al., (1971) over to a rat-model.  

The most numerous group of neurons, the MSP-neurons, are defined by an average 
diameter between 12-14 µm, but with a variation between 9-18 µm (Kemp et al., 1971; 
Dimova et al., 1980) and with a scant/medium and pale cytoplasm. These cells have a large, 
round and pale nucleus, combined with a round/polygonal body (Kemp et al., 1971; Dimova 
et al., 1980). The group of small-sized neurons can sometimes be hard to differentiate from 
glial cells based on size, but the neurons have more oval/round nuclei, pale and with 
distinctive nucleoli, and a dark cytoplasm with few Nissl-bodies (Kemp et al., 1971; Dimova 
et al., 1980). By contrast, glial cells have dark and irregular nuclei with clumped chromatin, 
which makes it hard to distinguish the nucleoli (Kemp et al., 1971). Table 1 (modified from 
Kemp et al., 1971) gives a summary of the distinctive morphological features of the 
different striatal cells.  
 
Table 1: Listing of the major different groups of neurons in the striatum and glial cell  

Cells: Morphology: 

Small: 
Round/oval nucleus, pale prominent nucleoli. Dark cytoplasm. Few Nissl-
bodies. 

          
          

Medium spiny projection neuron:  
Round and pale nucleus. Scant/moderate amount of cytoplasm. 
Round/polygonal soma. 

      
      
 

Medium long axon:  

Medium smooth: 

Like MSPN, but the differentiation from the former lies in numbers of 
dendrites, axon length, spines, and collaterals.* 
  
    

Varicose dendrite:     
          
          

Large: 
Resemble MSPN, but have more indentations and Nissl-bodies. Differentiate 
also in the aspect dendrites, etc.  

          
          

Glial cells: Dark and irregular nucleus, with crumbled chromatin.   
* For further details, see Kemp et al., (1971); Mensah et al., (1974) and Dimova et al., (1980). 
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Figure 1: montage of five different photomicrographs showing the dorsal striatum. The 
boundaries employed in the present study are marked with a red contour. ac: anterior commissure, 
cc: corpus callosum, lv: kateral ventricle, rf: rhinal fissure 

4.3. Protocol 
 
The objective of the study is to perform a quantitative comparison of cellular elements in 
transgenic HD rats and a wildtype control. To establish this design to the material at hand, 
we need to define a) a reference volume, b) sampling parameters for the optical fractionator 
method, and c) morphological parameters to differentiate striatal cells.  
 
4.3.1 Defining the region of interest (ROI)  
To calculate a reference volume, the region of interest must be delineated in both groups of 
animals using explicit anatomical criteria. In the present study, the primary region of interest 
is the dorsal striatum. No formal consensus seems to exist in the literature about the 
anatomical delineation of the striatum, and sometime a combination of neurochemical and 
anatomical criteria are employed (Voorn et al., 2004; Kántor et al., 2006; Ingham et al., 
1998; Van de Berg et al., 2000). In histological material, the dorsal and lateral boundary of 
the striatum is readily defined by the overlying white matter (external capsule). Anteriorly, 
the genu of the corpus callosum provides a distinct boundary, and posteriorly the fornix 
joining the diencephalon forms an important landmark. The medial boundary follows the 
lateral ventricles. The ventral boundary of the dorsal striatum is difficult to delineate 
cytoarchitectonically (Voorn et al., 2004) and we have therefore employed an arbitrary 
definition (Ingham et al., 1998; Van de Berg et al., 2000), by drawing an imaginary line 
between the inferior tip of the lateral ventricle and the rhinal fissure (Fig. 1). In contrast to 
studies:  Kántor et al., (2006), Ingham et al., (1998), Van de Berg et al., (2000), and even 
though this study is basically enclosed to the striatum, is there no exclusion of globus 
pallidus in this study, due to the indifference in the objective of both the protocol and the 
pilot study. 
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4.3.2 Sampling parameters 
 After the recognition of the appropriate specimen, defining ROI and some of the different 
parameters, a determination of the number of sections needed should be done. Several 
factors influence the decision, raging from the tissue at hand, ROI to timeline. The numbers 
of sections must succeed each other, thereby generating a sections-series. In this production, 
every forth section was counted, with an interval of 200 µm, resulting in a succeeding 
section-series of total four sections from one single animal. Gundersen et al., (1987) 
recommends 10-20 sections per animal.    

The independent nature of the optical fractionator protocol towards size, orientation 
and spatial shape of the cells/tissue (Schmitz et al., 2005; Lucocq, 2007; West et al., 1991), 
is embedded in the concept of systematic, random sampling (Andersen et al., 1999; West et 
al., 1991; Lucocq, 2007; StereoInvestigator Users Guide, 2008). A two-step systematic, 
random sampling is applied (West et al., 1991; StereoInvestigator Users Guide, 2008), with 
first a random selection of the start-point of the section-series, and second, a random set 
point for the counting frame (both generated by the same software) (StereoInvestigator 
Users Guide, 2008). The latter yields a randomly placed mesh of counting frames within the 
section, with every counting frame being spaced in a standardized distance from each other. 
  Due to the possibility of bias in the recognition process, a blinding of the investigator 
is proposed by an anonymization of the slides. It is done by generation of a “random 
number” identification for each one of the sections, using the stereological software.  

In the study of Gundersen et al., (1987), 100-200 cellular elements were counted, 
with the application of about 100-200 counting frames, in 10-20 sections per animal. The 
counting frame was sized to sample 1-2 cellular elements each. In the objective of a pilot 
study, an oversampling is advised, due to an unknown CE, etc. (StereoInvestigator Users 
Guide, 2008). A count between 500-1000 cellular elements/animal is, thus, set as the aim of 
the study and protocol. A feasible count of cellular element/counting frame is therefore set to 
minimum 5 elements/counting frame for this study. This should in general range between 1-
6 (StereoInvestigator Users Guide, 2008). In the thionin stained striatum of rats, is a 
reasonable size of the counting frame therefore 65 µm x 65 µm. With only four sections 
being counted per animal, does this account for about 25-35 counting frame/section, and set 
the grid size within the section to 600-650 µm x 600-650 µm, calculated automatically by 
the stereological software in this production. The number of counting frame per section 
defines the grid size. A part from this, the biological variation is an important factor, and a 
study with 3-5 animals in each group should be conducted, if it happens to be unknown 
(Keuker et al., 2001; Cruz-Orive et al., 1990; West, 1994; Lucocq, 2007). The guard zone 
and counter frame height seems to be the parameter which are hardest to define for this 
protocol. There is seemingly no consensus about these, but several articles have defined 
them between 2-5 µm (StereoInvestigator Users Guide, 2008; Keuker et al., 2001; 
Schumann et al., 2006) and about 10 µm (West et al., 1991), accordingly. One approach is to 
define the upper guard zone in the range of 2-5 µm, the counting frame height at 10 µm 
(West et al., 1991), and let the lower guard zone vary coherently with the tissue thickness 
(Keuker et al., 2001). Regardless of this; no specific size on the guard zones were used in 
this production, but they were defined by the distance between the section top/bottom and 
first/last cellular element fulfilling the requirements during a scroll-down from the top to 
bottom, respectively, thus yielding a more unsecure, but, a more efficient protocol. Counter 
frame height was set between the two guard zones. This strategy was seemingly allowed by 
the comparative nature of the study, and would 
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Figure 3: High-power photographs of a coronal thionin stained section through the striatum showing detailed 
cellular morphologies. Panels A and B show neuronal nuclei (black arrows), with prominent nucleoli and 
“granules”. Panels C and D show glial cells (red arrows), with dark and clumpy nuclei. 

 otherwise be defined in accordance to studies like Keuker et al., (2001) and Schumann et 
al., (2006). 
 As proposed, must the different parameters be calibrated to the goal of the study, 
tissue at hand etc., so a pilot study is always recommended by the literature 
(StereoInvestigator Users Guide, 2008; Schmitz et al., 2005; Keuker et al., 2001). A CE 
should always be calculated, also (Keuker et al., 2001; StereoInvestigator Users Guide, 
2008).  
 
4.3.3 Morphological criteria 
Given the morphological characteristics of striatal cells (Table 1), it is possible to 
differentiate them in thionin stained sections, at least in the objective of neurons and glial 
cells. Glial cells have a more irregular and dark shape of the nucleus with no clear nucleoli 
(Kemp et al., 1971), thus, facilitating the differentiation from pale and oval/round formed 
nucleus of the neuron, with distinctive nucleoli and granules (Figure 3D). This 
differentiation can be done without difficulties in older animals (Fentress et al., 1981). The 
criteria defines that only cellular elements with oval or circular nuclei (Fig. 3A), as well as 
visible granules and nucleoli (Fig. 3B), will be counted, thus, there is no distinction between 
different neuron groups. To avoid multiple sampling of the same cellular elements, only 
elements in focus are sampled.  Somewhat similar approach has been used in other 
population estimation-studies (e.g. Schumann et al., 2006; Bjaalie et al., 1997).  
 
In summary, the following inclusion criteria are employed to ensure that our quantification 
is restricted to striatal neurons. Sampled cellular elements must: 

1. be in focus  
2. have a visible oval or circle shaped nucleus 
3. have visibly labelled granules or nucleoli 
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4.3.4 Summary 
Using the methodological parameters described above, is the following procedure suggested 
to perform a quantification of cell numbers and densities in thionin stained sections from the 
rat striatum. Only a short summery of the procedure will be given here (see the Appendix for 
further details). The basis of the pilot study is to determine appropriate sampling parameters 
and counting criteria. After a calibration of the parameters, a more profound study can be 
initiated, implementing the given criteria.    
 

1. Define the goal of the study, along with the specimen of interest, etc. 
2. Define the number of animal needed. The biological variation can be delineated from 

a pilot study with 3-5 animals in each group (Keuker et al., 2001; Cruz-Orive et al., 
1990; West, 1994; Lucocq, 2007). 

3. Define the number of sections needed. Gundersen et al., (1987) recommends between 
10-20 sections.  

4. Define the block advance (the succession within the sections-series). This is based on 
several factors, like availability of sections, and can be calibrated with the use of 
“variance of systematic random sampling“ (intersectional variance). A high number of 
intersectional variance in itself or compared to “variance due to noise” (intrasectional 
variance), should yield a larger section-series within an animal (StereoInvestigator 
Users Guide, 2008). Define the counting frame size. It should enclose 1-6 cellular 
elements per frame (StereoInvestigator Users Guide, 2008).  

5. There is no consensus about this, but several articles have defined the guard zone 
between 2-5 µm (Keuker et al., 2001; Schumann et al., 2006), and the counter frame 
height about 10 µm (West et al., 1991, etc). A method described in the literature 
(Keuker et al., 2001), is to place a standardized guard zone in the top, set the counting 
frame height about 10 µm, and let the bottom guard zone vary in accordance with the 
sections thickness.  

6. A blinding of the investigator is proposed by an anonymization of the slides, after 
generation of a “random number” identification for each one of the sections, using the 
stereological software. With all of this done, start sampling with the given 
morphological criteria 

 
  
4.4 Pilot study 
 
To test the delineated optical fractionator procedure on a realistic material, we performed a 
limited investigation using a total of eight thionin-stained sections from two rats, one 
transgenic HD rat and one wildtype control. The protocol was implemented with the block 
advantages set at 200 µm, counter frame size of 65 µm x 65 µm and the grid size to 600-650 
µm x 600-650 µm (see section: Stereological parameters, above). Due to the variation of 
sectional area, was the number of systematically, but random positioned counting frames, 
put between 27-35 frames per section. A 63x-objective was used to facilitate the detection of 
cellular morphology (Figs. 2 and 3). Details and result are shown in Table 2. A simple 
density estimation, based on the total number of cellular elements in all counter frames, 
divided on the total number of counter frames, points towards a lower density rate in the 
advantage of tgHD (9.23 compared to 9.36 cellular elements/counting frame). This seems to 
correspond with population estimation of tgHD-rat in other studies (e.g. Kántor et al., 2006), 
and, thus, supporting the theory of striatal atrophy in Huntington’s disease (Huntington’s 
Disease Collaborative Research Group, 1993; Vonsattel et al., 1998; Heinsen et al., 1994; 
Hedreen et al., 1991; Sapp et al., 1999). However, no conclusions can be drawn from this 
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pilot study due to limited number of sections and animals investigated, etc., and the 
differentiation could be due to i.e. biological variance. Presently, we have no measurements 
of the biological variation, so a larger study is recommended, with a group size of 3-5 
animals (Keuker et al., 2001; Cruz-Orive et al., 1990; West, 1994; Lucocq, 2007). 

The stereological parameters and counting criteria chosen seems to correspond to 
other population estimation studies (i.e. Schumann et al., 2006; Bjaalie et al., 1997), even 
though they seemingly result in an oversampling. We conclude that the procedure is readily 
implemented, and yields realistic numbers, but has to be calibrated to decrease the chances 
of oversampling. 
 

 
 

 
5. Discussion  
 
The objective of the present study has been to establish a stereological procedure for 
quantifying cellular elements in thionin stained, striatal sections in the rat brain. A literature 
review was conducted to select an appropriate design, a practical procedure was suggested, 
and then tested in a limited pilot study. 

The literature review reveals that there is limited consensus in the use of 
stereological methods and their parameters (Gardella et al., 2003), even though some 
recommendation exist (Gundersen et al., 1987; West et al., 1991; Keuker et al., 2001; 
Schmitz et al., 2000). The challenge has therefore been to extrapolate these 
recommendations to fit our needs. There are several protocols for quantification of cellular 
populations (Lucocq, 2007; Schmitz et al., 2005; Gundersen, 1986; Mayhew et al., 1996), 
each with many variable parameters that need to be adapted to the material investigated.  

The optical fractionator probe is found to probably be the most popular probe to 
estimate population densities (Glaser et al., 2000), and even though it is quite efficient and 
precise (West et al., 1991), does it have its restrictions (Schmitz et al., 2005); some confined 
to the design-based nature, while other more specific for the optical fractionator. The more 
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general restrictions are primarily confined to inhomogeneous shrinkage and compression, 
accessibility to all the whole region of interest and to incomplete penetration of dye 
(Schimitz et al., 2000; Schmitz et al., 2005; Gardella et al., 2003; West et al., 1991). In 
contrast to many other probes, is the fractionator approach seemingly unaffected by the 
former (Lucocq, 2007). Some of the specific restrictions to the optical fractionator probe, are 
confined to its need for a standardized height of the counting frame (disector) and guard 
zones (West et al., 1991; Andersen et al., 1999). While the former is needed for the 
calculation of the fraction the virtual counting frames constitute of a reference volume (i.e. 
West et al., 1991), are the latter necessary to prevent aberration on the surface after 
production of the sections, like  lost-caps, fragments etc., to exert bias (Schmitz et al., 2005, 
Andersen et al., 1999). In the pilot study, we used a simplified approach, defining the guard 
zones by the distance between the section top/bottom and first/last cellular element fulfilling 
the requirements during a scroll-down from the top to bottom, respectively, and the counter 
frame height was defined as the distance between these two. The literature 
(StereoInvestigator Users Guide, 2008; Keuker et al., 2001; Schumann et al., 2006; West et 
al., 1991; Andersen et al., 1999) as well as this protocol, recommends a counter frame height 
set at about 10 µm. The top guard zone should be between 2-5 µm, and the guard zone in the 
bottom, should vary in accordance with the section thickness, as done in the study by 
Keuker et al., (2001). 

Other potential pitfalls with this study seem to be connected to the morphological 
criteria, primarily formulated into two distinctive problems. The first one is confined to the 
possibility of extrapolation of morphological data from one animal on to another, while the 
other is confined to potential of subjectivity, due to morphological criteria. As mentioned 
under section 4.2, above, is there seemingly high concordance of morphological features 
among different animal models, thus, making it possible to extrapolate the morphology 
described in cat by Kemp et al., (1971) over to a rat-model. In respect to the second 
problem, while the methods applied are quite objective, an element of subjectivity is 
introduced when the investigator selects which cellular elements to include. The use of 
explicit morphological inclusion criteria is therefore seemingly important, and should be in 
context with the difficulties in discrimination of the different cellular elements. If it is hard 
to differentiate the different cellular elements, should the criteria also be that precise. The 
discrimination between neuron and glial cells has been described as readily by the literature 
(Fentress et al., 1981), thus, lowering the chance for subjectivity. As a ramification of this, 
could it be interesting to see whether a modification of the protocol is able to differentiate 
the different groups of neurons. Regardless, a blinding of the investigator is proposed by an 
anonymization of the slides, after generation of a “random number” identification for each 
one of the sections, using the stereological software, to decrease any given possibility of 
subjectivity.  

The primary alternative to the given protocol is the use of specific immuno-
histochemical staining techniques to visualize specific cell types (see Pickel, 1981), thus 
providing a higher precision to the study and avoiding the possibility of subjectivity and 
morphology. A standard thionin-stain is, on the other hand, both cheaper and more time 
efficient, so a consideration must be done. In our case, the latter was found to be more 
important.   

Our pilot investigation yielded population density counts in line with previous 
literature (Heinsen et al., 1994; Kántor et al., 2006). The average cell density was slightly 
lower in the transgenic HD rat compared to the wildtype control, which would fit with the a 
priori expectation. However, given the limited number of sections and animals investigated, 
these numbers cannot be used to draw any conclusions. The reciprocal value of the square 
root of total number counted, has been found to approximate the real CE of the fractionator 
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(Schmitz, 1998; Schmitz et al., 2000; Schmitz et al., 2005). With a count of minimum 1000 
cellular elements/animal in the pilot study, should this yield a CE less than 0.05. Thus, the 
biggest variation would be due to biological variance (Keuker et al., 2001). With biological 
variance being unknown, is the recommendation (Keuker et al., 2001; Cruz-Orive et al., 
1990; West, 1994; Lucocq, 2007), to conduct a study with 3-5 animals per group. The 
stereological parameters and morphological criteria chosen correspond to the 
recommendations and to other similar studies (i.e. Schumann et al., 2006; Bjaalie et al., 
1997), even though they seemingly result in an oversampling. Consequently, this protocol 
should yield statistical valid result, even though a calibration through a larger study should 
be done.  
 

6. Acknowledgments 
We thank Anna T. Bore and Bjørnar T. Antonsen for histological processing and staining, 
and Yvette C. van Dongen for helpful advice on basal ganglia anatomy and delineation. 
 



 16 

7. References: 
Andersen BB, Gundersen HJG. (1999). Pronounced loss of cell nuclei and anisotropic deformation of 

thick sections. J Microsc. 196:69-73. 
Bjaalie JG, Brodal P. (1997). Cat pontocerebellar network: numerical capacity and axonal collateral 

branching of neurones in the pontine nuclei projecting to individual parafloccular folia. Neurosci Res. 
27:199-210. 

Cajal SR. (1911). Histologie du Système Nerveux de l'Homme et des Vertébrés, II. Paris: Maloine. 
Cruz-Orive LM. (1999). Precision of Cavalieri sections and slices with local errors. J Microsc. 193:182-

198. 
Cruz-Orive LM, Weibel ER. (1990). Recent stereological methods for cell biology: a brief survey. Am J 

Physiol. 258:L148-56. 
Dray A. (1979). The striatum and substantia nigra: a commentary on their relationships. 

Neuroscience.4:1407-39. 
Dimova R, Vuillet J, Seite R. (1980). Study of the rat neostriatum using a combined Golgi-electron 

microscope technique and serial sections. Neuroscience. 5:1581-96. 
Fentress JC, Stanfield BB, Cowan WM. (1981). Observations on the Development of the Striatum in 

Mice and Rats. Anat Embryo1.163:275-298. 
Folstein SE. (1989). Huntington's disease: A Disorder of Families. Baltimore: Johns Hopkins University 

Press. 
 Gardella D, Hatton WJ, Rind HB, Rosen GD, von Bartheld CS. (2003). Differential tissue shrinkage and 

compression in the z-axis: implications for optical disector counting in vibratome-, plastic- and 
cryosections. J Neurosci Methods. 124:45-59. 

Glaser JR, Glaser EM. (2000). Stereology, morphometry, and mapping: the whole is greater than the sum 
of its parts. J Chem Neuroanat. 20:115-26. 

Glaser EM, Wilson PD. (1998). The coefficient of error of optical fractionator population size estimates: 
a computer simulation comparing three estimators. J Microsc. 92:163-71. 

Goodman LA. (1961). Snowball sampling. Annals of Mathematical Statistics. 32:148–170. 
Gundersen HJG. (1977) Notes on the estimation of numerical density of arbitrary profiles. The edge 

effect. J. Microsc. 111:219-223. 
Gundersen HJG. (1986) Stereology of arbitrary particles. A review of unbiased number and size 

estimators and the presentation of some new ones, in memory of William R. Thompson. J 
Microsc.143:3–45. 

Gundersen HJ, Bendtsen TF, Korbo L, Marcussen N, Møller A, Nielsen K, Nyengaard JR, Pakkenberg B, 
Sørensen FB, Vesterby A, et al. ( 1988). Some new, simple and  efficient stereological methods and 
their use in pathological research and diagnosis. APMIS. 96:379-94. 

Gundersen HJG, Jensen EB. (1987). The efficiency of systematic sampling in stereology and its 
prediction. J Microsc. 147:229-63. 

Gundersen HJG, Jensen EB, Kiêu K, Nielsen J. (1999). The efficiency of systematic sampling in 
stereology - reconsidered. J Microsc. 193:199-211. 

Harper PS. (1996). Huntington's disease, 2nd Edition. London: WB Saunders. 
Harper PS, Wood JD, Jones AL. (1997). Huntington disease: Advances in molecular and cell biology. J 

Inher Metab Dis. 20: 125 – 138. 
Hedreen JC, Peyser CE, Folstein SE, Ross CA. (1991). Neuronal loss in layers V and VI of cerebral 

cortex in Huntington's disease. Neurosci Lett.133:257-61. 
Heinsen H., Strik M., Bauer M., Luther K., Ulmar G., Gangnus D., Jungkunz G, Eisenmenger W., Gotz 

M. (1994). Cortical and strital neurone numberin Huntinton’s disease. Acta Neuropathol. 88:320-333. 
Huntington's Disease Collaborative Research Group (1993). A novel gene containing a trinucleotide 

repeat that is expanded and unstable on Huntington's disease chromosomes. Cell. 72: 971-983.  
Howard CV, Reed MG. (1998).Unbiased Stereology. Three-Dimensional measurement in microscopy. 

Oxcord: BIOS Scientific Publishers.   
Ingham CA, Hood SH, Taggart P, Arbuthnott GW. (1998). Plasticity of Synapses in the Rat Neostriatum 

after Unilateral Lesion of the Nigrostriatal Dopaminergic Pathway. J Neurosci. 18:4732-4743. 
Johnson CD, Davidson BL. (2010). Huntington's disease: progress toward effective disease-modifying 

treatments and a cure. Hum Mol Genet. 19:R98-R102. 
Kántor O, Temel Y, Holzmann C, Raber K, Nguyen HP, Cao C, Türkoglu HO, Rutten BP, Visser-

Vandewalle V, Steinbusch HW, Blokland A, Korr H, Riess O, von Hörsten S, Schmitz C. ( 2006). 
Selective striatal neuron loss and alterations in behavior correlate with impaired striatal function in 
Huntington's disease transgenic rats. Neurobiol Dis. 22:538-47. 

Kemp JM, Powell TP. (1971). The structure of the caudate nucleus of the cat: light and electron 
microscopy. Philos Trans R Soc Lond B Biol Sci. 262:383-401. 



 17 

Keuker JI, Vollmann-Honsdorf GK, Fuchs E. ( 2001). How to use the optical fractionator: an example 
based on the estimation of neurons in the hippocampal CA1 and CA3 regions of tree shrews. Brain 
Res Brain Res Protoc. 7:211-21. 

Leontovich TA. (1984). On the fine structure of the subcortical ganglia. J Nevropatologii. i Psikhiatrii. 
54:168-183. 

Lucocq JM. (2007). Efficient quantitative morphological phenotyping of gentically altered organisms 
using stereology. Transgenic Res. 16: 133-145. 

Mayhew TM, Gundersen HJG. (1996). If you assume, you can make an ass out of u and me: a decade of 
the disector for stereological counting of particles in 3D space. J Anat. 188:1–15. 

MBF Bioscience (MicroBrightField, inc.). (2008). Stereo Investigator 8 User’s Guide - Document 
Version SI0108-08. Williston: MBF Bioscience (MicroBrightField, Inc.). 

 Mensah P, Deadwyler S. (1974). The caudate nucleus of the rat: cell types and the demonstration of a 
commissural system. J Anat. 117:281-93. 

Mitchell IJ, Cooper AJ, Griffiths MR.(1999). The selective vulnerability of striatopallidal neurons. Prog 
Neurobiol. 59:691-719. 

Miyamoto K. (1994). Particle Number and Sizes Estimated from Sections —A History of Stereology, in 
Research of Pattern Formation, Takaki R. (Ed.). (Tokyo:  KTK Scientific Publishers):507-16.  

Nguyen HP, Kobbe P, Rahne H, Wörpel T, Jäger B, Stephan M, Pabst R, Holzmann C, Riess O, Korr H, 
Kántor O, Petrasch-Parwez E, Wetzel R, Osmand A, von Hörsten  S. (2006).  Behavioral 
abnormalities precede neuropathological markers in rats transgenic for Huntington's disease. Hum Mol 
Genet. 15:3177-94. 

Petrasch-Parwez E, Nguyen HP, Löbbecke-Schumacher M, Habbes HW, Wieczorek S, Riess O, Andres 
KH, Dermietzel R, Von Hörsten S. (2007). Cellular and subcellular localization of Huntingtin 
aggregates in the brain of a rat transgenic for Huntington disease. J Comp Neurol. 501:716-30. 

Pickel VM. (1981). Immunocytochemical methods., in Neuroanatomical Tract-Tracing Methods. Heimer 
L (Eds.), Robards  MJ (Eds.). (New York: Plenum Press):483-510.  

Reiner A, Albin RL, Anderson KD, D'Amato CJ, Penney JB, Young AB. (1988). Differential loss of 
striatal projection neurons in Huntington disease. Proc Natl Acad Sci U S A. 85:5733-7. 

Sapp E, Penney J, Young A, Aronin N, Vonsattel JP, DiFiglia M. (1999). Axonal transport of N-terminal 
huntingtin suggests early pathology of corticostriatal projections in Huntington disease. J Neuropathol 
Exp Neurol. 58:165-73. 

Schmitz C. (1998). Variation of fractionator estimates and its prediction. Anat Embryol. 198:371–397. 
Schmitz C, Hof PR.(2000). Recommendations for straightforward and rigorous methods of counting 

neurons based on a computer simulation approach. J Chem Neuroanat. 20:93-114. 
Schmitz C, Hof PR. (2005). Design-based stereology in neuroscience. Neuroscience. 130:813-31. 
Schumann CM, Amaral DG. (2006). Stereological analysis of amygdala neuron number in autism. J 

Neurosci. 26:7674-9. 
Sterio DC.  (1984).The unbiased estimation of number and sizes of arbitrary particles using the disector. J 

Microsc. 134:127-36. 
Van de Berg WD, Blokland A, Cuello AC, Schmitz C, Vreuls W, Steinbusch HW, Blanco CE. (2000). 

Perinatal asphyxia results in changes in presynaptic bouton number in  striatum and cerebral cortex-a 
stereological and behavioral analysis. J Chem Neuroanat. 20:71-82. 

von Hörsten S, Schmitt I, Nguyen HP, Holzmann C, Schmidt T, Walther T, Bader M, Pabst R, Kobbe P, 
Krotova J, Stiller D, Kask A, Vaarmann A, Rathke-Hartlieb S, Schulz JB, Grasshoff U, Bauer I, 
Vieira-Saecker AM, Paul M, Jones L, Lindenberg KS, Landwehrmeyer B, Bauer A, Li XJ, Riess O. 
(2003). Transgenic rat model of Huntington's disease. Hum Mol Genet. 12:617-24. 

Vonsattel JP, Myers RH, Stevens TJ, Ferrante RJ, Bird ED, Richardson EP. (1985). Neuropathological 
classification of Huntington’s disease. J Neuropathol Exp Neurol. 44: 559-577. 

Vonsattel JP, DiFiglia M. (1998). Huntington disease. J Neuropathol Exp Neurol. 57:369-84. 
Voorn P, Vanderschuren LJ, Groenewegen HJ, Robbins TW, Pennartz CM. (2004). Putting a spin on the 

dorsal-ventral divide of the striatum. Trends Neurosci. 27:468-74. 
West MJ. (1993). New stereological methods for counting neurons. Neurobiol. Aging,. 14:275–285. 
West MJ. (1994). Advances in the study of age-related neuron loss. Semin Neurosci. 6:403-411. 
West MJ. (2001). Design based stereological methods for estimating the total number of objects in 

histological material. Folia Morphol. 60:11–19. 
West MJ, Slomianka L, Gundersen HJG. (1991). Unbiased stereological estimation of the total number of 

neurons in the subdivisions of the rat hippocampus using the optical fractionator. Anat. Rec. 231:482–
497. 

Zuccato C, Valenza M, Cattaneo E. (2010). Molecular mechanisms and potential therapeutical targets in 
Huntington's disease. Physiol Rev. 90:905-81. 



 18 

8. Appendix: 
Name    Optical Fractionator 
Date   28.09.2010 
Software  Stereo-Investigator 8.0 (MircorBrightField, Williston, VT; USA).  
  
Keywords  Counting, optical fractionator, stereo investigator, population 
estimation 
Author   Saurabh Kumar Jain 
Reference       MBF Bioscience (MicroBrightField, Inc.). (2008). Stereo Investigator 

8 User’s Guide - Document Version SI0108-08. MBF Bioscience 
(MicroBrightField, Inc.). Williston.2 

 

Optical Fractionator 
 
Purpose:  is to estimate the population of defined subject(s) within a specified 

area(s). 
 
Prerequisites  a “Preliminary Population Estimate” and/or “Optical Fractionator 

Workflow”- should be performed in advance to get the feeling for 
suitable parameters regarding the estimation. (You find both functions 
under “Probes”.) 

 
Procedure 

1. Tools->Random Number Generator. Use this function to define 
which section you will work on.  

2. Set a set point. TIPS: Position the set point equivalently on every single 
section; i.e.: the top of the left corpus callosum.  

3. Trace you region(s) of interest. TIPS:  It is easier to trace with the 
“Rubber Line Tracing”. It is also better to trace within the area of 
interest, rather than making the contour too vast, including too much 
unwanted area. 

4. Change to magnitude of choice. Remember to change the “Change 
Lens”- function in the program as well, to corresponding lens.   

5. Hit the “Adjust Video Input”-button (Imaging->Adjust Camera 
Settings). Use the auto-exposure to find the right exposure.  

6. Probes->Define Counting Frame. Define the counting frame size, as 
well as the position on the screen. TIPS: Place it within the auto-move 
box (the dotted-square right in the central of the screen).  

7. Probes-> Preview SRS Layout.  TIPS: It is easier to define the 
“SURS Grid Size” based on “Desired Sampling Site”. Type in the 
desired number, and then hit: “Estimate Grid Size”. Round the size-
number to nearest 50. Hit “OK”. If you are not satisfied, hit the 
“Preview SRS Layout” once more, and try again. Satisfied: hit 
anywhere on the screen to exit. An appropriate size is 600-650 µm x 
600-650 µm, and should be kept equal for all sections.  

8. Left side of the screen. Choose a marker. 

                                                 
2 This is a modified version of the protocol given in StereoInvestigator Users Guide version 8, (2008), made  to 
fit this need of this study. Part of this protocol, can be quoted directly from the mentioned User Guide. 
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Figure 2: Counting frame, with in-and exclusion lines. The red lines are exclusion lines; 
the green lines are inclusion lines. All cellular elements in focus and 1) falling within the 
square, without touching the exclusion lines, or 2) touching the inclusion line, without 
being in touch with the exclusion lines, are marked with a star, and thereby counted. The 
counting square is marked by a square. 

9. Probes->Optical Fractionator.  Hit “NO” on the pop-up (if you are 
not using “Serial Section Manager”). Another pop will appear. Do not 
change anything, but hit “OK”. This will start the counting. Focus at the 
top of the section (debt wise). On the next pop-up, you could either find 
the bottom or just hit “Do Not Measure”. ‘ 

 
Counting:  The sampling follows a set of rules (Gundersen et al., 1977; Keuker et 

al., 2001), with the aim to serve objectivity to the counting process. A 
part from the criteria set to recognize cellular elements of interest, are 
the counting criteria given as follow: 1) All cellular elements falling 
within the counting square are counted, when they are in focus. 2) All 
elements touching the inclusion (green) line are counted when they are 
in focus. 3) All elements outside the square or touching the exclusion 
line (red), are not counted. 

 
 TIPS: Remember to define standardized guard zones, and a standard 

height for the disector (Andersen et al., 1999). One approach is to 
define the upper guard zone in the range of 2-5 µm (StereoInvestigator 
Users Guide, 2008; Keuker et al., 2001; Schumann et al., 2006), the 
counting frame height at 10 µm (West et al., 1991), and let the lower 
guard zone vary in concordance with the tissue thickness (Keuker et al., 
2001).   

 
Click on the cell to mark them. Hit F2 to go to the next counting frame. 
Right mouse click provide other functions as well. TIPS: Have well-
defined criteria before counting. 
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10. After finishing counting, go to Probes->Display Probe Run List. You 

can change the run list and repeat it, watch the results etc. For now, just 
watch the results. Then hit: “Copy All Results to Clipboard”. Paste 
the results into an exel-sheet, and save this.  

11. If you want to save the tracing and marking as a photo-file, do as 
follows: 
Toolbar: Find the button with a question mark and a box: “Where is”.  
Hit it, then: Edit-> Copy to Clipboard (BMP), and finally hit Edit-
>Paste from Clipboard. TIPS: You should also acquire pictures 
within the contour of the section itself; Image->Acquire picture. Place 
yourself at several different positions within the contour to acquire 
picture of the whole section of interest. Remember: Joy-free/Joy-track 
must be turned off.  
Then use Edit->Copy to Clipboard (BMP) and “Paste from 
Clipboard” 

12. Save everything. File->Save as. Save the file either as .dat- or .asc-file. 
The acquired pictures should be saved as .tif. 

13. Start with a new section. Repeat everything. 
Optional: 

Tool ->Start Serial Section Manager-> New Section 
Block Advance: the thickness at which the tissue was cut. (Generally 
about 50 µm) 
Mounted Thickness: Final mounted thickness (due to 
shrinkage).Generally about 12-20 µm. (You can change it later on.)  
Evaluation Interval: Numbers of section that you skip over. (For 
instance: If you got total of 50 sections and you count 10, you type 5.) 
Block advance: added (if you start counting from the rostral part) 
 
Leave the rest as it is. After finishing this section, just add a new section 
the same way throughout the procedure.  
 
+: It will calculate the result for every single/selected section compared 
to each other, so you do not have to do it manually. 
-:  The contours will be placed upon each other. 
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